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System Profile (System Information)
In Church Windows, the System Information screen contains your organization's name and address, and
also gives you the opportunity to customize your copy of Church Windows. Many of the changes you
make on this screen will not take effect until you exit Church Windows and re-open the program.

l

To reach the System Profile:
l From the Initial Button Bar, click on the Admin button.
l Choose System Info from the popups that appear above it. The System Information
screen will appear:

Product Improvement Program
There is a checkmark at the bottom of this screen for this option. This program helps Computer
Helper Publishing improve this product for you. The information that is gathered cannot be used
to identify you or your organization or contact you, nor is any of the data entered by your organ-
ization collected. Without interrupting you, this program periodically uploads information about
your PC hardware and general usage data (to let us know which portions of the product are being
used the most).
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Church Name and Address
The church name that appears here on the System Information screen is the one that was
entered as the name of your church when Church Windows was first installed.

To enter or change your organization's address and phone number, click the appropriate fields
and make your changes. This information appears at the top of Church Windows reports and as
the return address on Contribution Giving Statements. The City, State and Zip code entered here
will be the default address information when you enter a new household.

Tax ID Number (for non-profit organizations)
In the Tax ID Number field on the System Information screen, enter your organization’s tax
identification number, if you have one. This number will print on Giving Statements printed from
the Donations module and on 1099’s printed from the Accounting module.
If the Country field is set to Canada on the System Profile screen, this field will be called Regis-
tration Number.

Country (USA or Canada)
If you are a Canadian customer, then on the System Information screen, click the down arrow
in the Country field and select Canada. Once you make this change, then the City, State field
will change to City, Province, the Zip Code field will become Postal Code, and the Tax ID num-
ber will become Registration Number.
This change also affects Contribution Giving Statements. Giving Statements are renamed to
"Donation Receipts" and comply with Revenue Canada requirements.
(See the Canada book of this Manual/Help system for detailed information about using Church
Windows in Canada.)
If you are a US customer, then leave the Country field at USA.

Licensing Tab
This will give you information regarding which products you have licensed.

About Tab
This tab shows information about Church Windows and how to contact us.

You are here: Admin > Security and Passwords
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Security and Passwords
People that use the Church Windows software are kept track of as Users on the Security screen. The
Security screen is a panel of options where you can designate only certain Users to have access to
Church Windows and its features. From the opening screen of Church Windows, click Admin and then
click Security to bring up the screen:

IMPORTANT: When logging into Church Windows, you will need to know the Username, not the Full
Name. The Full Name is only for reference in the security screen and is not used to log in, so make sure
any new user that is set up knows their Username since it will need to be typed in. There is no longer a
dropdown list of names to choose from.

You can click the button to Save Permissions to do so as you make adjustments to this screen. Click
Print Permissions to print them out. Continue through all settings and tabs until you have completed set-
ting up your list of Users. Then click Save & Close to retain your changes and exit the Security screen.

Users

The Users list is set up to accommodate a set of permissions per User added to the list. Therefore, des-
ignating the Users of this software means that you must also designate the features that you want each
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User to use. Once there has been at least one (1) Active user added to the list of Users, the software
will open to a screen prompting you to enter a Username and enter a Password. NOTE - only one per-
son can be logged in as a certain user at any given time.

To add a User to the list in the security screen, click the + Add button. The information for New User 1
will appear in the list and in the Full Name field on the System tab, on the right side of the screen.
Replace New User 1 with the Full Name of the person you are letting have access to the software.
Enter a desired Username and Password for the User in the boxes provided. To help you verify that you
have entered the password you intended, click the word Password next to the field. The items entered in
the field will turn from asterisks to the text you typed. Double click the word Password to change the
text back to asterisks when finished. Every user MUST have a password.

Note: When setting up Users, make sure that you allow access to the Security screens for at least one
user. Doing so will give one user the ability to make changes to User information and make any changes
to software feature access privileges as needed.

Click to place a check mark in the Access Security Screens box to allow the User to open the Security
screen and make changes to Security and Passwords information on this screen. Place a check mark in
the Restore Backups box to allow the User access to the Restore Data feature found under the System
Administration menu.

The System Profile screen is a panel where you can make changes to general software settings, includ-
ing the software license activation and the organization (church location) information. See the article
titled System Profile (System Administration) for further information.To give the User access to the
System Profile feature found under the System Administration menu, click the option to give the User
one of the following levels of access:

l None: The User will be able to click the System Administration menu to view the menu options,
but will not be able to click the System Profile screen. The option will be grayed out.

l Read-only: The User will be able to click the System Profile option under System Administration
and view the screen settings, but will not be able to change anything that has been entered in the
fields.

l Full: The User will be able to view and/or change settings on the System Profile screen without
restriction.

As long as you allow at least one User the access to the Security screens, you can go back to make
changes to any other settings you make on the Security screen.

Membership & Scheduler tab

The options on this tab control the selected User's access to Membership & Scheduler module features
of the software. Under the desired option, click None to prohibit access, Read-only to allow access for
viewing purposes only, or Full to allow complete access (including the ability to make changes).
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Donations tab

For the selected User to be able to enter the Donations module features, make sure that you place a
check mark in the Allow User Access to Donations Module. Or, remove the check mark to prohibit the
user from having any access.

The tab also contains a list of features in the software where you can give the User a specific level of
access to each listed feature. Next to each desired feature, click the box to place a checkmark under
each of the following applicable columns:

l View: When checked, the User will be allowed to open and view the screen items.
l Create: When checked, the User will be allowed to add new information.
l Modify: When checked, the User will be allowed to make changes to information already
entered.

l Delete: When checked, the User will be allowed to remove information.

Place a check mark in Account Order, if you wish the user to have access to the Order Accounts fea-
ture found in the Accounts & Pledges menu in Donations. If you wish the User to be able to access and
make changes to the Settings feature found in the Special Functions menu, place a check mark in the
Modify Settings box. Also, choose between allowing the User the ability to see Giver names by placing
a check mark in the Show Giver names - Limited functionality if unchecked.

Note: When unchecked, the options you select in the list will change to allow the User to use Donations
without seeing names. Givers without Giver # will not be displayed. Also keep in mind that when show-
ing Giver names is not allowed, many parts of Donations are not accessible.

Accounting tab

For the selected User to be able to enter the Accounting module features, make sure that you place a
check mark in the Allow User Access to Accounting Module. Or, remove the check mark to prohibit
the user from having any access.

The tab also contains a list of features in the software where you can give the User a specific level of
access to each listed feature. Next to each desired feature, click the box to place a checkmark under
each of the following applicable columns:

l View: When checked, the User will be allowed to open and view the screen items.
l Create: When checked, the User will be allowed to add new information.
l Modify: When checked, the User will be allowed to make changes to information already
entered.

l Delete: When checked, the User will be allowed to remove information.

Place a check mark next to the box to Allow Access to Bank Reconciliation and/or Allow Closing
Accounting Year to allow the User to do so. If you wish to give the User access to the Renumber
Chart of Accounts feature, place a check mark in this box.
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Restore History

Keep track of data that has been backed up and restored onto your installation of Church Windows by
reviewing the list found on this tab. The Database Restored column shows the module affected by the
item in the list. Backup Date and Date Restored show the time and date that the action took place. By
having set up Users, your screen will also show you that the data was Restored By a specific User (the
Full Name listed for the User). The Computer (User) column shows the name of the computer (set up
on the Computer itself) and the name of the User (or Username listed in the Security screen of Church
Windows on the Users tab).

If you wish to document your report history, you can click the button to Export Restore History.
A message will show you that the file was saved to a specific location and ask you if you would like to
open the folder. The file is saved as a PDF file. If you choose to open the folder you can then move the
file to any other location you wish.

You are here: Admin > Backing up Church Windows
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Backing up Church Windows
Church Windows includes a backup program that will back up your Church Windows data files for you.
This program compresses files for storage on another media such as flash drives.

However, if you have a different backup program that you use regularly, you are welcome to back up
Church Windows using that program. To back up all of your Church Windows data, select all of the files
in the "Data" subdirectory of your "CW" directory.

To use the Church Windows Backup program:

l Click Admin and choose Backup

l In the What to Backup box, select which data files you would like to back up.

l In the Backup To field, select the media that you will be using to store your backed up inform-
ation, such as a flash drive. The system defaults to the drive most recently used to create a
backup. To change this backup destination, click the Browse button and select the drive or dir-
ectory you’d like to back up your data to.

l If the system detects already existing data in your backup destination, it will ask you if you’d like
for the existing data to be erased. You can then change the location to one that does not have such
files already existing. If you do not switch to a location that is empty, and choose to overwrite the
existing backup files in any particular location, the information previously saved in that location
will be erased. It will then be replaced with the contents you have chosen to back up.

l To begin the backup, click Start Backup. The program will compress your Church Windows data
and store it onto the selected drive.

l Depending on your selection in the What to Backup box, the compressed backup file will be
named:

l CWMSDA.zip if you selected to back upMembership, Scheduler, Donations, Account-
ing

l CWMSD.zip if you selected to back upMembership, Scheduler, Donations
l CWA.zip if you selected Accounting only, and
l CWPicts.zip if you selected Pictures

l After the backup has completed, make sure you keep track of where you have saved the inform-
ation.

Remember: Any backup program is not effective if it is not used properly. Some helpful hints are:

l Take the most current backup OFF SITE! A backup will do you no good sitting in the drive of a
computer that has been stolen.
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l If in the event you restore a backup to your computer, keep in mind that it will delete the current
data and restore the data back to how it existed at that exact point when the backup was made.
Any changes made since that backup will be lost.

You are here: Admin > Restoring a Church Windows Backup
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Restoring a Church Windows Backup
To restore a backup that was created using the Church Windows Backup Program:

l Click Admin and choose Restore Data. (OR, if this is a new install, it will ask if you are restor-
ing a backup, and you can choose to Restore Existing Data) If you get a window saying File Not
Found and that the location specified does not contain a backup, just click Cancel and it will let
you into the restore screen.

l If this is NOT a new install: If the Restore Data option is grayed out, then your Church Win-
dows password does not allow you access to this feature. Click System Administration and
Security (or have your system administrator do this) to change your password access. This fea-
ture can be disabled for users since an accidental restore could possibly result in data loss.

l When you select Restore Data, the system checks for a backup file to restore from. The system
will default to restoring from the drive that was used for the last backup created. Once the
Restore Data screen is open, you may then click Browse and select the location of the backup
file that you’d like to restore.

l Click Start Restore. The system will replace your current Church Windows data with the data
file(s) you selected.
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Sending Emails from Church Windows

In order for an individual in either the Members file or the Visitors file to be emailed, the recipient must
have a valid email address. In addition, people entered into the Membership database (Members or Vis-
itors) could have more than one email address. For example, you might have a second email address
field for a work email address. 

The first thing to do is to set the email settings. NOTE: If you previously converted to the Don-
ations module and emailed the Donation statements, this has already been done.

Setup the Email Settings

To get here:
→ Membership
→ Reports

→ Email

If you are ready to send an email, you can set the criteria to select the individuals here. For the purpose
of setting up the email settings, click Next.

Different users may set up the email settings for the email account they wish to use for sending the
emails from. The Office Administrator may want to email newsletters or individuals; the Choir Director
may want to email the members of the choirs. Each can configure their own email account from which
to send messages. The information entered for each user will  be saved; it will only need to be entered
once. If you have been using the Donation module to email Donation statements, the information is
already entered and need not be re-entered unless a new user is creating their email settings.

On the Options tab, there is a field for the Email Setting.
l To create a new setting, click the Plus (+) sign beside the field.
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l The Setup SMTP Email screen opens which stores the settings that make it possible for you to
email people out of the database.

The screenshots included here are samples only and are not necessarily what you will use with your pro-
gram. You might need the assistance of the person who set up the email system for your church. The
Church Windows support staff would not know this information.

l Display name (For ‘Email Settings:’ Internal to this program only): The name entered in this
box is the name under which the settings you make on this screen will be saved. This then allows
you to choose a Display Name from the Email Settings box on the Options tab when sending state-
ments by email.  Different groups within the church can be set up with their own Display Name
for different mailboxes and each can send the donation statement from the system. An example
might be “Secretary’s Mailings” (without the quotation marks).

l Outgoing Mail Server (SMTP): Select an existing name from the drop-down box. If you have not
yet set this up, click the Plus (+) sign.
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Note:We recommend that you use the SMTP Host, Port, and SSL information provided by your Internet
Service Provider (ISP). This information can be obtained by searching the Internet or contacting their cus-
tomer support.

A sample might be outgoing.verizon.net

You may, alternatively, be able to use the SMTP server of your Webmail Host; however, many Webmail
hosts have strict limits on the number of emails you can send per day.  If your email is @YourOr-
gName.com, then you may be able to use SMTP settings provided by the host that you purchase your
web space from or the settings for your in-house mail server.

l

When the information has been entered on this screen, be certain to perform the connection test. 
If successful, you should receive a message similar to this:

l Click OK if the connection test was successful. If the connection test fails, the data entered is
wrong.
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l

‘From’ Email Address: Click the Plus (+) sign to enter your (or your organization’s) email
address. This is the address your email will be sent from.  Select an existing email address from
the drop-down box.

l

Username: This is the username for your Outgoing SMTP Mail Server if you used your Internet
Service Provider (ISP) or Username for your ‘From’ Email account if you used your Email host
for your SMTP.

l Password: This is the password for your outgoing SMTP Mail Server (the password you use to
log into your ‘From’ Email if you used your Webmail Host’s SMTP).

l

‘Reply To’ Email Address (If different than ‘From’ Email): Click the Plus (+) sign to set up
the email address people will use to send a reply. (Optional) If a recipient replies to your emails
by clicking ‘reply’, the email will be sent to this address.

It is important that you: Review the information to make sure that all the information you intend to
save is correct. Then click the Send Test Email button. Type an email address that you know you can
immediately access. Click OK and a message will be sent to the email address you specify. Check to
see if you received an email message with the subject “TEST Email” from (the ‘From’ Email Address:
or ‘Reply to Email Address (If different than ‘From’ Email): address you entered. After receiving the
test email, click the OK button on the Setup SMTP Email screen to complete the email setup.
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For information on how to prevent your email from ending up as Spam/Junk/Blocked, click the Question
mark icon and read the tips we have give you.

Email an Individual

InMembership, find the individual’s Household and Individual record or click to open the Contact
List.

l Click the Email icon on the individual’s record.

l If you opened the Contact List, find the individual and click to highlight the name. The person
should show an email address. Click the Email button.
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The email screen opens and the individual’s name shows in the list of names.

l Click to select the Email Setting to use.

l To enter an email message, click the Plus (+) sign beside Email message.
l Compose the email message and enter a Subject if you choose to.

l

The Home tab allows you to set use standard word processing options – such as setting the font
style and size, changing the color of the text, etc.
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l The Insert tab allows you to insert picture or symbols or files in the email.

Here we have attached a file to the email.

Once the email is ready, click on the Options tab to send the email.
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You see the many options available.

Click the one of your choice.

l To send the email, click Send Email.

his screen opens.

l at the bottom of the screen, select the Email Settings being used.
l To send the email, click Send Email at the bottom of the screen.
l If this is a message you might use again, after entering or sending the email, click to Save it.



19

The system will confirm that it has been saved. Saving the email means that you will be able to call it
up, make any necessary edits to it, and send it again.

When you close the Message screen, you will be asked if you wish to save this email.

l If this is an email you will send at another time, you can answer Yes and use it again.

Re-use a Saved Email Message

In this example, we are sending an second email to Bob Jones about serving as liturgist in the
Anniversary Service. We saved the first one and now wish to use it again.

l Go to the appropriate Household and Individual Record screen in Membership or use the
Contact List to select the recipient. 

l Click to select the Email Setting to be used.
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l Click the down arrow in the Email Message box and click to select the original one used.

l

Click Send Email.

When you send emails out of church Windows, it provides you with a Results screen providing inform-
ation on the emails sent.

Email a Group of People

The Adult Choir will have an extra rehearsal on a certain date at a certain time in the Choir Room. 
Email the members a reminder notice!

From the Initial Button Bar

l ClickMembership, Reports, Email
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To select the people enrolled in a specific group or class,

l Click the down-arrow in the box ‘Select a membership field, make selections and click Add
Selection.’

So, in this example, we:

l Click on [Groups/Classes].

l

Click to place a check mark in the box for each group to be emailed.
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l After selecting the group(s), click OK.

l Click the + Selection button.

l Because we have asked for a specific group or class, we leave checked the boxes for both Mem-
bers and Visitors checked at the top of the screen . The system will pull only those people
enrolled in the class.

l

Make certain that on the right side of the screen,  the Also Include boxes are unchecked so those
individuals are not added to our list of emails.

l Click Next.

The Email Options screen opens. We see the names of the people in the group(s) we selected.
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l Select the appropriate Email Setting for this set of emails.

l Click the Plus (+) sign beside the Email Message box and enter a new email message or click
the down-arrow to select an message already saved.

l Click Send Email to send the email.

From the Contact List

You can email people directly from the Contact List, which is a listing of everyone entered into both the
Members File and the Visitors File who do not have a Reason for Termination code on their record.

l From almost any screen in Church Windows, click the Contact List button.

l If you are on the Household and Individual Record screen, click to un-check the Link to Member
file box.  If you are on the Initial Button Bar screen, you do not have to un-check the Link to Mem-
ber file box.

l Click to highlight the name of the first person you need to email. Holding the CTRL key down,
click to highlight all the other people’s names.

l Click Email.

l On the Report Format screen, click Send Email
and Bcc.



24

Continue on with the instructions as given above.

A very important note about compatibility:

Church Windows will attempt to open your default email client when you choose the email feature. This
should work with most mail programs; however, there are many different email programs available.
Some variation in functionality may occur.  Please check your email program’s documentation for inform-
ation. Church Windows will work with most MAPI-compliant email clients. If Church Windows is
unable to communicate with your email program, it will notify you and paste all the email addresses onto
your clipboard. You will then be able to open a new email message in your email program and simply
paste (Edit/Paste or CRTL-V in most programs) the email addresses into the To or Bcc line.
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NOTE:

l If your church sends bulk emails, go to our website – www.churchwindows.com – and click the
CW Partners tab at the top of the screen. Click to read about using our partner Constant Contact
for your bulk emails.

You are here: Admin > Database Maintenance

http://www.churchwindows.com/
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Database Maintenance
When you click on the Admin button and click on Support Functions, you will get a window with 2 tabs.

It will open to the first one, labeled Repair and Compact Access Databases. Clicking on this button will
run a brief maintenance routine on the few databases that are still in the Microsoft Access database
engine. Run this tool if you run into inconsistencies or errors within the program as a first line of
troubleshooting to see if it resolves the issue.

You are here: Admin > Canada Settings
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Canada Settings
When you set your Church Windows system to Canada, changes are made to the Membership and Don-
ations modules to better comply with the requirements of our Canadian customers.

To set your system to Canada:

l Click Admin and choose System Info.

l If you haven’t already, then enter your organization’s address and telephone information.

l In the Country field, click the down arrow and select Canada.

l When you make this selection, the address fields on the System Profile screen change to "City
Province" and "Postal Code". The "Tax ID" field becomes "Registration #". Enter your organ-
ization’s registration number into this field. This is the registration number that will print on dona-
tion receipts as required by Revenue Canada.

Selecting Canada in the Country field on the System Profile screen has the following effects in Church
Windows:

Membership: On the Members screen and the Visitors screen, "City State" becomes "City Province"
and "Zip Code" becomes "Postal Code." If you have already changed the names of these fields using the
Customize Fields screen, then your previous customizations will be retained and changing to Canada
will not affect these field names.

Donations: Under the Reports menu of the Donations module, the Donation Statement options will
make available to you the options of processing a Donation Receipt and a Replacement Receipt. Each
option will provide you with a tab called Options, from which you can Set Next Receipt #, and enter
the Canadian Tax Agency and Canadian Tax Website pertinent to your church.

You are here: System Administration/Features > Postage $aver > What is Postage $aver?
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What is Postage $aver?
Postage $aver is a PAVE-Gold certified program that processes your bulk mailings in a manner that may
reduce your mailing costs. PAVE-Gold is the highest level of certification that a program can attain with
the United States Postal Service (USPS). We have chosen Postage $aver as our partner to make Church
Windows more powerful in the administration of your organization’s mailing capabilities. Use Postage
$aver for mailings of over 200 pieces.

If you would like to try Postage $aver, you may install a trial version from the Church windows Install-
ation CD. After installing the program, go to System Administration, System Profile and click the
Browse button by the Postage $aver Location box. After the program finds the location, click OK. At
that point a message will appear notifying you that you have begun the 30-day trial. When the trial period
is over, you will need to purchase Postage $aver to continue using it. Contact Church Windows Sales at
800/533-5227 to purchase the program.

You are here: System Administration/Features > Postage $aver > What is Postage $aver?
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What is Postage $aver?
Postage $aver is a PAVE-Gold certified program that processes your bulk mailings in a manner that may
reduce your mailing costs. PAVE-Gold is the highest level of certification that a program can attain with
the United States Postal Service (USPS). We have chosen Postage $aver as our partner to make Church
Windows more powerful in the administration of your organization’s mailing capabilities. Use Postage
$aver for mailings of over 200 pieces.

If you would like to try Postage $aver, you may install a trial version from the Church windows Install-
ation CD. After installing the program, go to System Administration, System Profile and click the
Browse button by the Postage $aver Location box. After the program finds the location, click OK. At
that point a message will appear notifying you that you have begun the 30-day trial. When the trial period
is over, you will need to purchase Postage $aver to continue using it. Contact Church Windows Sales at
800/533-5227 to purchase the program.

You are here: System Administration/Features > Postage $aver > General Information about Bulk
Mailings

General Information about Bulk Mailings

You must have a permit from the USPS to send out bulk mailings. If you use Standard Bulk Mail, you
may qualify for a Non-Profit rate from the USPS. For further information about bulk mail, you can
request "Publication 95", also known as the "Quick Service Guide", from your local postmaster. We
have a copy of the form you need to fill out for Non-Profit status on our website at www.church-
windows.com. Another great resource for bulk mail is found on the Postage $aver website at www.save-
postage.com. Click the link "Bulk Mail Tutorial for Beginners"

If you are going to be printing barcodes on your labels, you need to have your database CASS Certified.
The postal service will certify your addresses one time for free, every time after that you need to pay for
the service.  Lorton Data is the company we recommend to handle all your Coding Accuracy Support
System (CASS) Certification needs.  The Lorton form can be accessed from our website at www.church-
windows.com. For your convenience, we have taken the opportunity to fill in some of the information
required. Your addresses should be CASS certified at least every six months. Please contact your Post-
master for further details. For more information on the CASS certification process in Church Windows,
see Church Windows' Compliance with USPS Requirements.

You are here: System Administration/Features > Postage $aver > Postage $aver and Church Win-
dows

Postage $aver and Church Windows

Connecting Postage $aver to Church Windows
After Postage $aver is installed and the correct Church Windows serial number is entered, click System
Administration and System Profiles. Click Browse at the bottom of the screen in the Postage $aver sec-
tion and it will browse the mapped drives automatically to find the Postage $aver program.

http://www.churchwindows.com/
http://www.churchwindows.com/
http://www.savepostage.com/
http://www.savepostage.com/
http://www.churchwindows.com/
http://www.churchwindows.com/
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If Postage $aver cannot be found on a mapped drive, an explorer window will appear and you can point
the system to the correct drive. The drive does not have to be mapped for Postage $aver to work. This
step will need to be completed on each computer that will have access to the Postage $aver program.

Once the Postage $aver box is filled in, close Church Windows and reopen the program to have Postage
$aver enabled.

If you would like to try Postage $aver, you may install a trial version from the Church windows Install-
ation CD. After installing the program, go to System Administration, System Profile and click the
Browse button by the Postage $aver Location box. After the program finds the location, click OK. At
that point a message will appear notifying you that you have begun the 30-day trial. When the trial period
is over, you will need to purchase Postage $aver to continue using it. Contact Church Windows Sales at
800/533-5227 to purchase the program.
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Running Postage $aver
You will receive an email from Postage $aver Software containing registration number and an update
code. You may have to enter this information on each workstation that will run Postage $aver reports.
Until this is correctly entered, you can use the program on a 45-day free trial.

Postage $aver will be accessible from Membership reporting screens where labels are an option.

If you wish to include Barcodes, you must choose a label at least 3½ inches in width per USPS reg-
ulations. Add barcodes to the labels by clicking the checkbox on the Label Options screen.

When Postage $aver is enabled, a new checkbox appears for Optional Endorsement Lines (OEL).
OEL’s look similar to "*******5-digit 43230". Use OEL’s on non-automation mailings. These mailings
will not have barcodes. This OEL line can be used in place of the colored D, 3, A, and MXD stickers on
the top of each bundle of mail.

Once you complete your settings on the Label Options Screen, Click Next to start the Postage $aver pro-
cess. It is critical that the screens are completed properly for the mailing to be accepted by the Post-
master. The user assumes all responsibility for all postage costs associated with the use of this software.
Please consult the Postage $aver help within the Postage $aver program and the USPS (www.usps.com)
for the most current mailing requirements.

Each Postage $aver screen that now appears will have the most current Help information. Once Postage
$aver has all of the settings entered, it will read your label selection and resort them to the correct USPS
requirements. You will have the option to print three reports at this time. The "Mail Preparation Instruc-
tions" report helps you organize your mailing, tells you how much money to take to the Post office, and it
gives you the information for the USPS Statement. Take the "USPS Qualification Report" to the USPS
office when you drop off your mailing. "Tray/Sack Tags" will print the cards to label your trays and
sacks. For this report you can use Avery 5371 (Postcards/Business Cards for laser printers) or Avery
8371 (Postcards/Business Cards for ink jet). If you skip these reports, you can access them from the

http://www.usps.com/


32

Postage $aver module directly, until the next mailing process you do.

Finally, the labels will be generated. If during the envelope labeling process, they get out of order, the
"Mail Preparation Instructions" report will guide you in getting the correct items in the tray or sack.
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